HOSTED VOIP COMMPORTAL GUIDE

WOW! Business
GETTING STARTED

When you go to the WOW! Business Hosted VoIP Web Portal link (https://voice.wowway.com/wow), the first screen that appears is your login screen. Enter your telephone number and password.

NOTE – Your initial password is provided in your Hosted VoIP Quick Reference Guide, or by asking your System Administrator.

Please note: you will need to change your password. For security reasons, your new password must be 6–10 digits. For improved security, passwords cannot have a letter or number that repeats three or more times (for example “AMJ25554”), can only have up to two sequential numbers (for example “AMJ2345”) and the password cannot be the phone number.

NOTE: This document shows an account with all features activated. Your actual screens may differ due to the features assigned to your account.
DASHBOARD

The Dashboard is the main view for the web portal. On this page you see the number of voicemails, missed calls, contacts and the Call Manager settings.

NOTE: For additional information on any setting, press the symbol to access the help files.
MESSAGES AND CALLS

**Messages**
To play a message, click on the > icon to bring up the Voicemail Player. To save a copy of the message on your computer, right click on the > icon, and select **Save Target As**... or **Save Link As**.

**Missed Calls**
This tab lists your recent missed calls. To add an unrecognized caller to your contact list, click on the + icon. To go to a contact’s entry in your contact list, click on their name.

**Dialed Calls**
This tab lists your recent dialed calls. The following actions are available to you on this tab. To add a dialed number to your contact list, click on the + icon. To go to a contact’s entry in your contact list, click on their name.

**Received Calls**
This tab lists your recent received calls.
CONTACTS

Contacts
To add a new contact to the list, click the New Contact button below the contact list column. Once you have finished entering the details for the new contact, click the Save button to submit your changes. If you wish to discard the new entry, click Cancel. To import, contacts must be in a CSV file format.

Finding a Contact List Entry
There are multiple ways of finding an existing contact list entry.

• **Alphabetically by name.** Scroll through the names in the contact list column, and click on the one you want to view the details of.

• **Searching by name.** To search by name type the first few letters of any component of the name into the search box at the top of the contact list column. Matching proceeds as you type, and the more you type, the more constrained the list of matches is. Matching is performed against contacts’ first and last names, and also against various other text fields within the contact.

• **Searching by number.** To search for a contact by number type the first few digits of one of their telephone numbers into the search box.
CONTACTS (cont.)

Extensions

Extensions allow you to quickly dial other numbers in the Business Group.

You can search by typing in the search box above the table. The list will be restricted to those items that match, with the matching field highlighted.
CONTACTS (cont.)

Short Codes

Short codes allow you to quickly dial common numbers.

You can search by typing in the search box above the table. The list will be restricted to those items that match, with the matching field highlighted.

• first calls your phone

• when you answer that, places the call to the target phone

• \text{typing the phone number}

• typing the name or start of the phone number and then choosing from suggestions from your contacts or extensions

• typing a “vanity number” in which letters are used instead of numbers

• dialing using the on-screen keypad.
**CALL MANAGER**

**Summary**
You can configure Call Manager to perform one of the following actions by selecting its corresponding radio button.

- **Ring your phone.** This will not apply any Rules to your incoming calls, and effectively turns off Call Manager. All incoming calls will make your phone ring.

- **Forward to voicemail.** This will divert all incoming calls to voicemail.

- **Forward unconditionally.** This will direct all your calls to another phone without applying any rules.

- **Apply one of your Sets of Rules all the time.** This ignores your Weekly Schedule and any Special Days.

- **Apply different Sets of Rules depending on the day or time.** This lets you choose which Set of Rules you want to apply. Selecting an action will activate any drop-down menus associated with that action. Use these drop-down menus to tailor the behavior of Call Manager by selecting forwarding options or a Set of Rules to apply as applicable.

Once you have made any changes, click the **Apply** button to save the changes, or click the **Cancel** button to cancel any changes.
CALL MANAGER (cont.)

Rules
You can use Rules to configure Call Manager to handle incoming calls based on your preferences.

You can define different rules for different callers, grouping these within Sets of Rules. When combined with your Weekly Schedule and Special Days, these allow you to change which rules apply according to the day or time. The first time you select this tab, you are given an explanation, and then will start with some typical Sets of Rules, which you can then edit to your needs.

Your Sets of Rules are listed in the left-hand side pane. To add a new Set of Rules, click Add new Set of Rules. A new window will open; enter a name for this new Set of Rules then click OK to create, or Cancel to bypass.

To find out what a Set of Rules does or to edit it, select it in the left-hand pane. The right-hand pane will then list the rules it contains. If the Set of Rules only contains one rule, that rule will be applied to all your incoming calls. If you want Call Manager to use another rule, click Add New Rule. This way you can specify how Call Manager will treat different types of callers. When applying a Set of Rules to an incoming call, Call Manager works from the top of the list of rules to the bottom. You can move a rule up or down the list with the Move Up and Move Down buttons.
CALL MANAGER (cont.)

If you want to make a change to an existing rule, highlight the rule in the right hand pane and click Edit. There is a backup rule that applies to all other types of call that are not covered by the existing rules in the set. You can change this by clicking the description of the action, which appears as a link above the right-hand pane.

Adding Rules

Define what calls the rule applies to.
CALL MANAGER (cont.)

Define what action will occur when the call is received.

The rule will now appear under the Sets of Rules Heading.
CALL MANAGER (cont.)

Weekly Schedule
The Weekly Schedule tab lets you configure Call Manager based on what you do in a normal week. Call Manager can apply a different Set of Rules for each period you define in your Weekly Schedule, so you can treat the same type of caller differently depending on what you would normally be doing at that time. You set that behavior from the Summary tab.

The first time you select the Weekly Schedule tab you can choose whether you want to start from an empty schedule, or have a typical schedule created automatically for you.

Once you have chosen an empty or typical schedule you are taken to the normal Weekly Schedule tab. The right-hand pane contains a timetable for the week, and the left-hand pane contains a list of the existing periods defined in your schedule. The periods are color-coded.

If you choose the typical schedule, a number of periods will have been defined for you. If you choose an empty schedule, you will have to create a new period before you can modify the timetable.

If you want to add a new period click **Add New Period**. A new window will open; choose and enter a name for this new period. The new period will then appear in the left-hand pane and will be assigned a color. You can define a maximum of 3 periods.
CALL MANAGER (cont.)

To create your schedule, first select a period from the left-hand pane, and then, in the right-hand pane, highlight the time ranges for that period. A single click highlights a 15 minute interval. Clicking and dragging allows you to highlight a longer time range, and you can drag across multiple days at once. The highlighting is color-coded to match the period you have selected. If you want to delete an entry in the timetable, click (or click and drag) over the entry again. You can overwrite an existing entry with a different period without needing to delete the entry first.

You can press 🕵️‍♂️ Zoom In to increase the size of the time segments, making it easier to highlight the correct time period, then press 🕵️‍♀️ Zoom Out to return to normal again.

If you want to delete an entire period, click the ✕️ icon next to the name of that period. You can rename a period using the Rename button. You cannot have 2 periods with the same name. Periods are listed in alphabetical order.

Once you have made any changes, click Apply to save the changes, or click Cancel to reject any changes.

You then need to choose a name this new time period. Example: Lunch, Working Hours, etc.
CALL MANAGER (cont.)

Special Days
The Special Days tab lets you define days on which you will not be following your normal weekly schedule. The Special Days tab shows a calendar. You can navigate through the months of the calendar using the:

- button to move to the previous month
- button to move back by 3 months
- button to move to the next month
- button to move on by 3 months.

To set a single date as a special day, click that date in the calendar. If you need to add a range of dates, you can click and drag on the calendar to highlight the necessary days. Once you have selected a special day it is highlighted. Clicking or dragging over a previous highlighted day will unselect it.
CALL MANAGER (cont.)

Call Manager also includes lists of the standard public holidays for the current year. This saves you from having to add each day as a special day yourself. To add these public holidays as special days in your calendar, click **Add Public Holidays**. A new window appears; select the list of public holidays that apply in your area. Click **OK** to have Call Manager add those public holidays as Special Days to your calendar, or **Cancel** not to. To delete all the Special Days you have defined, press **Clear All**. Once you have made any changes, click **Apply** to save the changes, or click **Cancel** to reject any changes.
SETTINGS

Account

Personal Details
- **Subscriber name**: This is the name that is associated with your Messaging account. It is used in the From address when you forward a message as an email.
- **Timezone**: This setting shows the time zone associated with your account. All times and dates displayed or configured via the Web UI will be relative to the time zone that you select here.

Security

The security page allows you to perform the following operations.

- **To change your password**, enter the new password, and then confirm it by entering it again, into the boxes. For security, the text will be hidden as you type. Click Change Password to make the change.

- **To change your Call Services PIN**, update the current PIN field to your chosen value and click Change to make the change.

- **To change your Voicemail PIN**, update the current PIN field to your chosen value and click Change to make the change.
SETTINGS (cont.)

Devices
This tab provides a link to the interface that you use to configure your desk phone. Clicking the link opens the interface in its own window.

On the next page is an example of a phone setup.
SETTINGS (cont.)

This is a sample of the Phones screen for a Polycom VVX400

Phone Settings
Phone Settings allows you to view and configure settings for the phones on your desk. You can configure the keys on the phone, and may be able to configure other settings such as ringtones, depending on what your Business Group Administrator has allowed you to do.

Selecting your phone
If you have only one phone, you can skip this section, as that phone will always be selected. If you have more than one phone, you will see a thumbnail picture of each of your phones. Click on the phone whose settings you would like to view or change. If the phone you wish to configure is not displayed, contact your Business Group Administrator.

Configuring keys
The easiest way to configure keys is via the Graphical View. This may not be available for all phone models. If available, the Graphical View is displayed by default when you select your phone. The Graphical View displays a picture of your phone and allows you to click on keys to configure them. To get to the Graphical View from the Table View, click the button in the bottom-right.
SETTINGS (cont.)

You will be able to configure some keys but not others. Which keys you can configure depends on what type of phone you are using, and what settings your Business Group administrator has configured. To find whether you can configure a key, move your mouse pointer over that key. If it turns into a hand icon, you can configure that key.

Click on a key to configure it. A dialog box will appear to allow you to select the function you want the key to perform from a list of all the supported functions. If the function you selected requires additional settings to be specified, the dialog will prompt you for these. For example, the Speed Dial function will prompt you to specify the telephone number to dial. You can type in the telephone number directly, or search by contact name for a number from your Contact List (or the other named lines in your business). To search by name simply start typing the name. A dropdown list of matching contacts will be displayed for you to choose from.

If available, the Enhanced Speed Dial and Enhanced Monitored Extension keys behave like Speed Dial and Monitored Extension keys with the exception that pressing the key while a call is in progress or ringing does an immediate “blind” transfer to the number or extension.

If available, Enhanced Call Park keys combine the function of a Park and Retrieve key into one button. Pressing an Enhanced Call Park key immediately transfers a call to the park orbit if it is free. If the park orbit is occupied and no call is in progress then pressing the button retrieves the parked call.

When you assign a function to a key, you can also specify the text with which you would like to label the key. This will be displayed when viewing keys in Phone Settings, and depending on the model of phone may be displayed on the phone’s screen or may be printed as a paper insert for the phone (see below). Note that each model of phone can display labels slightly differently. You should choose labels that are meaningful to you but be mindful that the phone may need to truncate the label depending on the phone’s screen size. In addition some phones use fixed labels for some functions. If you specify a label in this case, the label you specify will be displayed within Phone Settings, but will not be displayed by the phone itself.

For phones that have paper inserts instead of an LCD providing labels for the keys, you or your users can print out an insert for a phone. Once you have configured the keys with their labels, press the button, and select the appropriate “Inserts” option from the list of print options.

Configuring other settings
To configure settings other than keys, such as ringtones and call services, you will need to use the Table View. Press the button in the bottom-right to enter Table View. It is also possible to configure keys in this view, although it is easier to do so via the Graphical View.

Alerting Types contains settings for ringtones and visual indications of a phone call.
SETTINGS (cont.)

Call Services contains settings that allow you to override the behavior of some call services on the phone. On some phones there are specific keys and menus that map to these services. These keys and menus will behave according to these settings. The Table View displays the settings for your phone grouped into categories, in a hierarchy. For example, keys can be found in Phone Profile -> User -> Key Groups. To see a particular setting, either expand each category in turn by clicking on it, or select Expand all from the View menu. To hide settings, you can collapse categories by clicking the arrow to the left of them, or select Collapse all from the View menu.

If a setting is grayed out, you cannot change that setting. Otherwise, click on it to change it. There are three types of settings.

• “On/off” settings have a checkbox, which you can click to toggle.

• Keys can be assigned to a function, and clicking on them will bring up the same function menu as in the Graphical View, as described above.

• Other settings have a text box, which you can edit by clicking inside it and typing.

After left-clicking on either a setting or a category, you can use the following options in the Edit menu.

• Copy will store that setting, or all settings in that category, in the clipboard.

• Paste will overwrite the current setting, or all settings in the current category, with settings that were previously copied into the clipboard. This is useful to copy settings between different phones. Note that you must paste onto the same type of setting or the same category from which you originally copied. You can copy and paste the top-level Phone Profile category to copy all the phone’s settings.

• Reset will remove all of your configuration for the current setting or category, and revert back to the default settings configured by your Business Group Administrator, if any.

• Paging group configuration

• Paging group membership

• Paging group keys
SETTINGS (cont.)

Saving or discarding your changes

When you have finished making changes, you must either save or discard them.

• Press **Save changes** to store all your changes you have made. They will be applied to your phone when it next reboots, which is typically overnight.

• Press **Discard changes** to cancel all the changes you have made since the last time you clicked either **Save changes** or **Discard changes** for this phone.

If you have more than one phone, then clicking on either button will also take you back to the thumbnail view of all your phones, from which you can select another phone.

You can print out either a complete list of your settings or a list of your key bindings. Press the button, or select **Print** from the **File** menu in the Table View.
Calls
This tab provides access to a number of settings that you are unlikely to need to change on a regular basis. No changes that you make on this page will be applied until you press the Apply button.

Line Information
This allows you to see what the name of this line is, and if appropriate what department you are a member of.

You can also change the name of the line, and which department you can administer.

Voicemail Preferences
This allows you to set the time in seconds that your phone rings before the call is sent to voicemail. The acceptable range is from zero to 60 seconds.
Messages – General

Auto-Forwarding

You can select to forward all your received voicemails to the email account you enter. When doing this forwarding, you have the choice of leaving the messages so you can still access them here, or of deleting them.

You can also choose to include action links in the forwarded message. These links allow you to perform actions (e.g. deleting the voicemail) on the copy of the message stored in your messaging service.
**Messages – Mailbox Access**

These settings allow you to customize your experience when accessing your mailbox via the telephone.

- **Fast Login.** Generally when you dial into your mailbox you are asked to enter both your phone number and PIN. However, if Fast Login is enabled, then when accessing your mailbox from your own telephone, your phone number is recognized automatically and you only need to enter your PIN.

- **Skip PIN.** If Skip PIN is enabled, then when accessing your mailbox from your own telephone you are not required to enter your PIN. This saves you time, but reduces security as anybody with access to your telephone can then access your mailbox.

- **Auto-Play Voicemail.** If autoplay is enabled, then when you log into your mailbox, instead of hearing the main menu your messages will start playing immediately.

- **Voicemail Playback.** When your messages are played to you, you can choose whether you wish to hear the message details (who the message is from and when it was left), the message itself, or both.

After making any changes to your mailbox settings, press **Save Settings** to apply them.
SETTINGS (cont.)

**Caller Transfer**

- Caller transfer number. When a caller is put through to your Voicemail, they are given the option of being transferred to the number set by your business group administrator and specified here.

- Allow callers to send numeric pages. If this option is enabled, then when a caller is put through to your Voicemail, they are given the option of sending a page to the pager(s) that you have configured to receive pager notifications.

After making any changes to these settings, press **Save Settings** to apply them.

**Live Message Screening**

You can enable or disable live message screening using the checkbox, then pressing **Save Settings**.

![Image of settings interface](image)

**Messages – Voicemail Greeting**

This tab allows you to record your names and greetings. Greetings with an * next to them are already recorded.
SETTINGS (cont.)

Voicemail Greeting

The Voicemail Greeting panel allows you to configure which greeting will be played to callers who reach your voicemail. You can choose to either use a standard system greeting, record or upload and use a personal message of your choice.

You also have the option of just using the same greeting as your primary group mailbox.

As well as defining the default greeting that you wish callers to hear, you can also

• configure alternative greetings to be played outside business hours
• choose to play an extended absence greeting, and optionally prevent callers from leaving messages while you are away
• choose to play a different greeting when a caller comes from within your business group

After making any changes in the Voicemail Greeting panel you must press Apply to apply them.

Setting your default greeting

For your default greeting, you should select a greeting from the list of available greetings in the dropdown box. The list of greetings includes the following standard system greetings:

• System - this plays the normal system greeting, with no identifying information.
• System with Number - this plays the normal system greeting, including your phone number.
• System with Name - this plays the normal system greeting, but includes your recorded name.
SETTIXGS (cont.)

You can also choose to use a greeting where you can record or upload a personal message. Greetings that already have a recording will be marked with a * beside the name in the list. You can choose to re-record or upload a greeting if you wish by selecting it as your chosen greeting and clicking edit. Greetings that do not yet have a recording will display the record link that you can click to launch the Greeting Recorder pop-up. See message recording.

Once you have chosen, and if necessary recorded or uploaded, your voicemail greeting, expand the more options link to configure additional settings. These options will vary depending on the greeting that you are using.

For system and personal greetings, you can choose to do one of the following:

• play a different message outside of business hours. Use the record or edit link to create the greeting that will played instead of your default greeting when a caller is put through to voicemail because of the time of day that they are calling. You can configure your business hours by dialing into your mailbox.

• play a different message when the caller is a colleague in your business group. Use the record or edit link to create the greeting that will be played when one of your Business Group colleagues is put through to your voicemail.

Configure an extended absence greeting

If you are going to be away for an extended period, you can choose to use an extended absence greeting as your default greeting. If you have not already recorded or uploaded the message, you will see a record link alongside the message selection box. Click this link to launch the Greeting Recorder and record or upload your message.

When you are using an extended absence greeting as your default greeting, you can use the more options link to

• choose whether or not callers can leave you a message by clicking the “Allow callers to leave a message” checkbox. If you do not select this option then callers will be prevented from leaving you messages while you are absent. You may wish to do this to avoid your mailbox filling up while you are away.

• play a different message to colleagues in your business group whilst you have selected the “Extended Absence” greeting, by clicking the checkbox. Use the record or edit link to create the greeting that these callers will hear.

Use same greeting as primary telephone number

If you wish to use the same greeting as your primary telephone number, simply select “Same as primary” as your default greeting.

Download Greetings

To download a greeting, click the Download Greeting button, displayed in the greeting recorder, right below the recording buttons. Note that the download button will only be displayed if the greeting is already recorded and saved.
SETTINGS (cont.)

Recording a message
A number of controls are provided for recording your message.

- 🎤 Starts recording. This will overwrite any message you have previously recorded.
- ❌ Stops recording the message.
- 🎧 Plays back your recorded message. This action will be unavailable if you have not yet recorded a message.
- 🎧 Stops playing the message.
- 🔊 This control allows you to adjust the gain of your microphone. Click and then adjust the slider to set the required volume level. While recording, the 🟢 lights above this control will show how loud the signal is from your microphone. If the gain is set correctly then several green lights should appear while you are recording. If only one or two appear, then the gain is set too low and your message will be too quiet. If red lights appear then the gain is set too high and your message will be distorted.
- 🔊 This control allows you to adjust the playback volume. Click and then adjust the slider to set the required volume level.
- 🎵 This control allows you to view and change your Adobe Flash Player Settings, for example to adjust the settings for your microphone.

When you first attempt to record a message, an “Adobe Flash Player Settings” overlay will appear. Ensure that the “Allow” radio button is selected, and if you do not wish to be shown these settings in future tick the “Remember” checkbox.

To record a message you need to carry out the following steps.

- When you are ready to record your message, press the 🎤 button.
- Read your message into your microphone, and when you have finished, press the ❌ button.
- Playback your message to check that it has recorded correctly by pressing the 🎧 button. If you want to stop the playback, press ❌. If there is a problem with the recording, e.g. you cannot hear it, or it is very quiet, see the section on troubleshooting below.
- If you are not happy with your message content, then record a new message by pressing the record button again. This will overwrite your previous message.
SETTINNS (cont.)

Troubleshooting

I have recorded my message, but when I try to play it back I cannot hear anything.

• Check you have actually recorded something. The length of the current recording is shown as e.g. 0:01:35 (1 minute and 35 seconds). If the current recording length is 0 or much lower than expected then try recording your message again.

• Check that playback volume is turned up high enough. Volume can be adjusted using the volume slider described above.

• Try re-recording the message, and as you are recording, watch the lights on the player.
  - If no lights appear, or only one or two appear, then check the following.
    Increase the gain of your microphone by clicking and moving the gain control nearer to the top end.
    Click the icon to bring up the “Adobe Flash Player Settings” and make sure that the Allow option is selected. Click on the microphone icon at the bottom of this settings box and check that the correct microphone is selected in the dropdown, and that the record volume is turned up.
    If you are using an external microphone, check that this is plugged in correctly.
    If this still doesn’t solve the problem, then it may be that your microphone has been muted by the operating system (e.g. Windows) - refer to your operating system help for further information.

• If several green lights appear consistently while recording your message, then it is likely that your message has recorded correctly and the problem is occurring when playing it back. If you are using external speakers, check that these are plugged in correctly and turned on. If this does not resolve the problem, then it may be that your speaker has been muted by the operating system (e.g. Windows) - refer to your operating system help for further information.

I have recorded my message, but when I try to play it back it is distorted

This may be because your microphone gain is set too high. Reduce the gain by clicking and moving the gain control nearer to the bottom.
Notifications – MWI

You can use this panel to specify your other phones whose message waiting indications should be triggered when messages are received, and which types of messages cause the indication.

- To add another of your phones to the list, press **New Entry**. You are prompted for a phone number — this should be the number of another phone you own under the same account as this one; you cannot trigger indicators on arbitrary other phones.

- To change the types of messages that trigger the notification use the checkboxes.

- To delete a phone from the list, press the **X** icon.

- To clear the entire list, use the **Clear List** button.

If the **✓** shows, these notifications are enabled. Clicking this will switch between the **✓** enabled and **☐** disabled states.

You must press the **Apply** button for any of your changes to take effect.
SETTINGS (cont.)

Notifications – Email

This feature enables you to configure the voicemail system to send you an email when you receive a new message. You can choose whether you want an email to be sent every time you receive a message, or only when you receive a certain type of message, for example, an urgent voicemail. If you wish, you can have email notifications sent to multiple different email addresses.

- To add another email address to the list, press New Entry. You are prompted for an email address — as you type matching contacts from your contacts list will appear.

- To change the types of messages that trigger the email, use the checkboxes.

- To delete an email address from the list, press the ☓ icon.

- To clear the entire list use, the Clear List button.

If the ✔ shows, these notifications are enabled. Clicking this will switch between the ✔ enabled and ☐ disabled states.

You must press the Apply button for any of your changes to take effect.
SETTINGS (cont.)

Notifications – Pager

This feature enables you to configure the voicemail system to page you when you receive a new message. You can choose whether you want to be paged every time you receive a message, or only when you receive a certain type of message, for example, an urgent voicemail.

If the ✓ shows, pager notifications are enabled. Clicking this will switch between the enabled ✓ and □ disabled states.

If you wish, you can prevent pager notifications being generated at certain times, or on certain days by configuring a notification schedule.

To configure a new pager to receive notifications, press the New Entry button. You will then need to configure information about your pager, and the type of notifications you want to be generated.

First you must configure whether you use a telephone or email pager gateway. If people page you by sending an email then you should select email. Otherwise you should select telephone.

Once you’ve configured your new pager, press Add to add it to your notification list, and return to the main configuration screen. Note: your new configuration will not actually be saved until you subsequently click the Apply button to commit your changes. To remove a pager from your notification list, press the ✖ icon. You must press the Apply button for any of your changes to take effect.
SETTINGS (cont.)

Notifications – Outdial

This feature enables you to configure the voicemail system to call you whenever you receive a new message. You can choose whether you want to be called every time you receive a message, or only when you receive a certain type of message, for example, an urgent voicemail.

If the ☑ shows, outdial notifications are enabled. Clicking this will switch between the ☑ enabled and ☐ disabled states. If you wish, you can prevent outdial notifications being generated at certain times, or on certain days by configuring a notification schedule.

**To configure outdial notifications — enable the service by clicking ☐ to make it ☑.**

- Enter the phone number you wish to be called on when a new message is received.
- Select which types of messages you wish to be notified about.
- If you want to be notified immediately, select Immediate in the Delay for normal messages or Delay for urgent messages dropdown.
- If you only want to be notified after a delay, select the delay in hours in this dropdown.
SETTINGS (cont.)

You can also choose how many times you wish to be called for each new message.

• If you want to just be called once, set **Number of outdial retry attempts** to zero.

• If you want to be called repeatedly until either you answer the call or until you have actually read the new message
  • select either **Stop retries when you answer the call** or **Stop retries only when the message has been read**.
  • configure the maximum number of times you want the call to be retried.
  • configure how long you want the system to wait between retries.

You must press the **Apply** button for any of your changes to take effect.
Notifications – Override

This feature enables you to configure the voicemail system to notify you differently for a period of time. For example, while you are on vacation, you might only want to be notified of urgent messages and you might want to be notified in a different way from normal. Or, if you are normally notified by outdial, you might prefer to be notified by pager instead.

To override your normal notifications, enable the service by clicking [ ] to make it [ ].

If you wish, configure a notification schedule, so that notifications are only generated at certain times or on certain days

• choose whether you want to be notified by pager or outdial.

• specify when your notifications should reset back to normal by clicking the [ ] icon and choosing from the calendar, or by typing in the month, day and year fields.

• configure your pager notification or outdial notification as usual in the fields in this view.

You must press the Apply button for any of your changes to take effect.
SETTINGS (cont.)

Group Mailbox

The Group Mailbox tab allows you to administer your group mailboxes, and create new ones.

For each group mailbox, you can configure the following properties.

- Whether the secondary mailbox is currently enabled. If you disable a mailbox, then it is not possible to either leave messages in it, or retrieve messages from it. However all settings and content will be maintained, and you can re-enable the mailbox whenever you wish.

- The name of the mailbox user. This name is used, for example, when the user of the mailbox forwards a message as an email (the name is used to identify the user in the From field of the email).

- The mailbox PIN. This is the PIN used when dialing in to this mailbox, and when logging into the Web UI.

- Password. This is the password used when logging into the Web UI as this mailbox.

- MWI aggregation. If you enable MWI aggregation for a secondary mailbox, then any MWI notifications configured for your primary mailbox will also be triggered by messages left in this secondary mailbox. This is useful if, say, you share a single physical telephone with the user of the secondary account - enabling this feature means that the MWI indicator on the telephone will light if either of you have new messages.

- Message count aggregation. If you enable Message count aggregation for a secondary mailbox, then when you access your primary mailbox by dialing in from a telephone you are told both how many new and saved messages you have in your primary mailbox, and also how many you have in this secondary mailbox.

To add a new group mailbox, press the New Mailbox button. Once you have created a new secondary mailbox, you should login as the mailbox user, and record the user’s name and personal greeting. You can either do this by dialing into the mailbox from your handset, or by recording your “system with name” and “personal” greetings on the greetings tab on this page.

To delete an existing group mailbox, press the icon. Warning: deleting a group mailbox is an irreversible operation that will result in the loss of all messages and configuration associated with that mailbox.
SETTINGS (cont.)

Fax to E-Mail

To configure fax forwarding to an e-mail account, go to the Settings tab, then select Messages. Click on “add an email address” to define that e-mail address that you would like your faxes forwarded to.

Optionally, you may choose to have your faxes delivered to your messaging in-box as shown below.
SETTINGS (cont.)

This tab lists all of the faxes in your inbox. New faxes (those you have not yet read) appear in **bold type**.

For each fax in your inbox, you can see who sent the message, when the message was received, and how many pages the message contains. If the fax has been sent from a telephone number that appears in your contact list or the sender’s name was provided, then the name of the sender will be displayed. Otherwise, you will just see the number that the fax was sent from.

Your inbox may also contain special **System Messages**, such as delivery failure reports.

**The following actions are available to you on this tab.**

- View a fax or save a local copy on your computer
- Manage your faxes by deleting them, or marking them as either new or read
- Forward a fax
- View contact details or add new callers to your contact list.

**View or save a fax**

- To read a fax, click on the icon corresponding to the fax you wish to view.
- To save a local copy of a fax on your computer, right click on the ![File Icon] or ![Link Icon] icon, and select Save Target As... or Save Link As...
- To download a free PDF reader, click [here](#).

**Manage your faxes**

- To delete a fax, press ![Delete Icon] in the row corresponding to the fax that you want to erase. To delete all faxes, press **Delete All**.
- Faxes are automatically marked as read to when you play them. **To mark a fax you have previously read as new** (so that it appears in bold again), click the icon in the row corresponding to that fax and select “Mark as new” in the dropdown menu that appears.
- Similarly, **to mark a fax as read** without viewing it, click the icon in the row corresponding to that fax and select “Mark as read” in the dropdown menu that appears.
SETTINGS (cont.)

Forward a fax

If you wish, you can forward a fax as an email to one or more email addresses (the fax will be attached to the email as a PDF file). Alternatively, if you wish to forward a fax to another user (or users) on the same messaging system, you can forward the message as a fax so that it appears in their fax inbox.

**To forward a fax as an email:**

- Click the icon corresponding to the message you wish to forward, and select Forward as Email to bring up the Forward as Email overlay.
- Enter one or more recipients in the To field. If the recipient is configured in your contact list, then you can identify them by name. Otherwise you must enter their complete email address. You can specify multiple recipients by separating them with semicolons.
- The Forward as Email overlay also allows you to optionally
  - specify additional recipients in the Cc or Bcc fields
  - adjust the subject line of the email message
  - add text to be included along with the fax attachment.
- When you are done, press the **Send** button to send the message.

**Note:** when forwarding a message as an email, the From address specified will include your name as configured on the settings page.

**To forward a fax to one or more other users on the same messaging system:**

- Click the icon corresponding to the fax you wish to forward, and select Forward as Fax to bring up the Forward as Fax overlay.
- Enter one or more recipients in the To field. The recipients specified must be other users on the same messaging system, or the attempt to send the message will fail. If a recipient is configured in your contact list, then you can identify them by name, otherwise you must enter their fax number directly. You can specify multiple recipients by separating them with semicolons.
- You can optionally flag the fax as Urgent.
- When you are done, press the **Send** button to send the fax.

**View contact details or add new callers to your contact list**

- If a fax has been sent from a telephone number that appears in your contact list, then the name of the sender will be displayed. To view your contact list entry for the sender, click on their name and select “View contact”.
- Otherwise you will just see the telephone number that the fax was sent from. In this case, you can create a contact list entry for the sender by clicking on their number, and selecting “Add to contacts”.


COMMPORTAL ASSISTANT

This tab provides a link to download the toolbar installer.

Running the installer gives you a desktop toolbar, which offers

• access to contacts
• notification of new voicemails
• configuration of call services

all from the Windows desktop.
You will be provided with the required settings to configure CommPortal Assistant. The toolbar application is composed of the following parts.

- **Notification Area Icon** This component allows you to
  - configure your settings such as username and password
  - synchronize your local Outlook Contacts with your CommPortal ones
  - quickly access CommPortal.

- **Windows toolbar** The Windows toolbar allows you to search your contact list and configure any call services to which you are subscribed.
COMMPORTAL ASSISTANT (cont.)

Notification Area Icons
The notification area icon has 4 states:

- 🔄 Connected to the server
- 🔄 Connecting
- 🔄 Disconnected from the server
- 🔄 There is an Outlook Contacts synchronization conflict between Outlook and CommPortal

Launching CommPortal
When connected, double click on the icon to launch CommPortal.

The Notification Icon menu
To open the notification area menu, right click on the icon. The following menu options will appear:

- Open Dashboard: this gives you one-click access to your CommPortal dashboard
- Open Messages: one-click access to your voicemails
- Synchronize Outlook now...: this only appears if you have enabled Outlook
- Synchronization in the configuration options
- Configure: configuration options for the application
- Check For Updates: allows you to manually check that you are using the latest version
- Help
- About CommPortal Assistant: for licensing information and to access diagnostics if you should encounter problems
- Exit
COMMPORTAL ASSISTANT (cont.)

Changing your general settings
The settings dialog of the notification area icon allows you to change your username and password, proxy configuration and various other options.

The meaning of the settings are as follows:

• CommPortal credentials: enter your username and password for the service.

• Proxy configuration: if your Internet connection requires a proxy, you can enter the details here.

• Open automatically when Windows starts: tick this box if you would like the application to start whenever you start Windows.

• Display a popup when a new voicemail arrives: this tick box has no effect since you do not have voicemail.

• Check for updates automatically: tick this box if you would like the application to check for updates in the background. If an update is found you will be notified and asked if you would like it to be installed.

You can check for updates at any time by clicking the “Check for updates” entry on the notification icon’s menu.

LDAP Settings
If you have access to a Microsoft Active directory or another LDAP server then the toolbar allows you to search these external contacts and add them to your contact list.

For Microsoft Active Directory, no configuration should be required. To use a different LDAP server, click on the “LDAP Settings” tab.

By default, the “Use my Active Directory” box is ticked, this means that the rest of the settings are ignored and the toolbar attempts to contact the default Microsoft Active Directory.

To enter a different LDAP server, uncheck the box. The settings will then become enabled. You may now enter the details of your LDAP server. The details are specific to your network.

You should contact your network administrator if you need assistance.
Outlook Contacts Synchronization
If you use Microsoft Outlook 2003 or later you can configure CommPortal Assistant to automatically synchronize your local Outlook contacts and your CommPortal contacts.
COMMPORTAL ASSISTANT (cont.)

To setup synchronization configure the following.

• Select the Outlook Profile to use.

• Choose which direction you want synchronization to happen in.
  
  • Both directions will keep Outlook and CommPortal contacts the same, merging changes in both directions.
  
  • To Outlook Only will replace any existing Outlook contacts with your CommPortal contacts.
  
  • From Outlook Only will replace any existing CommPortal contacts with your local Outlook contacts.

• If you want synchronization to happen automatically every hour select the checkbox, otherwise synchronization can be manually started by right-clicking on the system tray icon and selecting “Synchronize Outlook now...”.

• Select which Outlooks Contact folder to synchronize with. Most people only have one folder, but you can select more than one if necessary.

After you have set up Outlook Synchronization, on each synchronization CommPortal Assistant will perform contact synchronization in the direction(s) you set. You will be warned about any conflicts that occur and shown them, allowing you to choose which contact to keep.
COMMPORTAL ASSISTANT (cont.)

Windows Toolbar

Overview
The Windows toolbar provides several useful functions described below:

- search your contacts
- ring your phone
- send all calls to voicemail
- forward all calls to a number of your choice
- use a configured set of rules
- use a schedule
- ring your phone
- forward all calls
- do not disturb

Opening the toolbar
Opening the toolbar follows the normal Windows procedure, described below:

- Right-click on an empty area of the Windows taskbar.
- Select Toolbars from the resulting menu.
- Click on the entry for CommPortal Assistant.

Searching your contacts

- Click on the text box on the toolbar (the hint text will disappear).
- Type your search text. A list of potential matches will appear as you type.
- If you see the required contact, select it with the mouse or by using the cursor keys. The contact’s details are displayed in a dialog box.
- If the toolbar cannot find any contacts then a message to that effect will be displayed. Choose the “Show more options...” entry in the list to search your external contacts.
- Click on the text box on the toolbar (the hint text will disappear).
- Type in the phone number you would like to dial, just as you would enter on your phone.
- Press the Enter key and a confirmation dialog will appear.
- Check the information in the dialog is correct and press the Dial button or press the Enter key to dial.
CommPortal includes a dialer function to allow users to dial using the application. It can be accessed by pressing the icon next to your phone number.

Dialer Icon
ADDITIONAL SUPPORT

Additional user guides and tutorials to assist you with your WOW! Business services can be found at wowforbusiness.com/support.